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Inteeeluetion

* Along time ago in a galaxy far, far away
... the Internet was created

* |t only served static web pages based on
HTML (HyperText Markup Language) Boring

» After a while, interactivity appeared:
,\ « JavaScript

i » Adobe Flash
1 (= Java Applet
A\ Q. ff-
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Tnitrecluetion

the Internet

* E.g. for teaching Physics, Chemistry, Math but
not only

» But, they don’t work in modern browsers

800 Java Application Blocked
Application Blocked by Java Security [(i%]

For security, applications must now meet the requirements for the High or Very High security settings,
or be part of the Exception Site List, to be allowed to run.

More Information

Name: Lorentzkraft
Location: http://www.walter-fendt.de

Reason: Your security settings have blocked a
Resurrect your Java applets JCrete 2015



http://www.walter-fendt.de/ph14e/
http://101science.com/chemJAVA.htm
http://www.math.ucla.edu/~tao/java/index2.html

Seilvtions?

* DukeScript

« HTML 5 / Javascript
o ?
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Skellaton eif e Jiver Aeje o

public class MyApplet extends java.applet.Applet {

public void init () { ... }
public void start() { ... }
public void paint (java.awt.Graphics g) { ... }
public void stop() { ... }
W public void destroy () { ... }

|

J <APPLET code="MyApplet.class" width=600

w |height=600></APPLET> I N
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Fapleleils Sfever Aeeifo

public class Tendrils extends public void start() {
Java.applet.Applet {

private static final int X 300; public void paint (Graphics
private static final int Y 300; |g) {
// max number of segments cluster.display (g, SEGS,
private static final int SEGS = X, Y)i
60; }
private Cluster cluster;
public void stop () { }
public void init () {
setSize (600, 600); public void dispose () { }

cluster = new Cluster ()
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Fapeleils Sfver Aeiellaf (eenit)

private static class Cluster {
// Number of helixes in a cluster
private static final int NUMBER = 7;

public void display (Graphics g, 1nt size, 1int

x, int v) {
for (int 1 = 0; 1 < NUMBER; 1++) {

double theta = 1 * 2 * Math.PI / NUMBRER;
Tendril t = new Tendril () ;
W t.display (g, size, theta, x, V);




Fapeleils Sfver Aeiellaf (eenit)

private static class Tendril ({
// Numerator of probability
private static final int NUME = 30;
// Denominator of probability
private static final int DENOM = 100;
// length of line segments
private static final double RAD = 3.0;
// change in angle theta (in rad)
private static final double DELTHETA = 0.1;
W // division of number of helixes
private static final int REDUX = 3;
// min number of segments |
private static final int MIN = 1; (




Fapieleils Shver Aeiellar (eeinit: )

if

public void display (Graphics

g, 1nt size, double theta,
int x, 1nt y) {

for(int 3=0; j<size; J+t) {

int chng = ((int) (DENOM *
Math.random()) < NUME) ? -1
1;

theta += chng * DELTHETA;

int x0 = x;

int y0 = vy;

X += RAD*Math.sin(theta);

y += RAD*Math.cos (theta);

}

(size < 4)
g.setColor(Color.red);
else 1f (size < 13) {
g.setColor (Color.green) ;
else 1f (size < 40) {
g.setColor (Color.cyan) ;
else {

g.setColor (Color.yellow) ;

.drawLine (x0, v0, x, Vv);

(size > MIN) {
Cluster ¢ = new Cluster();
int newsize = size / REDUX;

c.display (g, newsize, x, V)
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Pres & Clopls

* + Write In Java

* + A lot of documentation

* + Rich Ul widgets

- Jars do not run in the browser

' » - Need to learn a new API Iif you are not
\ familiar with JavaFX before, but part of

I [Java (AWT = Swing > JavaFXx) :
‘\J Y a\

s L : \n 7\ .«.(
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Clreeite et wan el FX crere) llezition

 |[n NetBeans:

* File > New Project
- Categories: JavaFX
* Projects: JavaFX Application




public class TendrilsFX extends Application {
// max number of segments
private static final int SEGS = 60;
private static final int X = 600;
private static final int Y = 600;
private final Cluster cluster = new Cluster();
@Override
public void start (Stage primaryStage) {
Canvas canvas = new Canvas (X, Y);

GraphicsContext g2D = canvas.getGraphicsContext2D() ;

cluster.display(g2D, SEGS, X/2, Y/2);
StackPane root = new StackPane();
root.getChildren () .add (canvas) ;

Scene scene = new Scene (root, X, Y);
primaryStage.setTitle ("Tendrils!");
primaryStage.setScene (scene);
primaryStage.show () ;

8/6/2015 Resurrect your Java applets - JCrete 2015
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lendaistaxe(Cants)

(size < 4) {
setStroke (javafx.scene
else 1f (size < 13) {
setStroke (Javafx.scene

else 1f (size < 40) {
setStroke (Javafx.scene
else {

setStroke (Javatfx.scene

strokeLine (x0, v0, x,

7 { N

.paint.Color

.paint.Color

.paint.Color

.paint.Color

V) ;

.RED) ;

. GREEN)

.CYAN) ;

. YELLOW



Categories:

@ Sources

@ Libraries
¥ @ Build
@ Compiling
2 Packaging
@ Deployment
@ Documenting
Run
Application
License Headers
Formatting
Hints
JaCoCoverage

Weooowe o

Configuration:

Runtime Platfor!

[ <default config>

m: | Project Platform

3| | Manage... |

Application Class: [tendrilsfx.TendriIsFX

Parameters:

VM Options:

] [ Browse... ]

l

(e.g. ~-Xms10m)

|_| Use Preloader:

Browse...

Preloader Class: | <No Preloader Class Available>

Run:

= Clean [

() Standalone () as Web Start

Standalone Application Properties

Working Directory: I

I 600 Height: |600 '

Web Start and B|
Width:

Web Page:

Web Browser:

| | Browse.. |

[

] [ Browse... }

(Leave empty for generated web page)

| <Default System Browser>

l

Help

| | cancel | [ oK ]



http://docs.oracle.com/javafx/2/deployment/deployment_toolkit.htm

Plzeiloy (2)) - Fliraten

Control Panel

* Click on Edit Site
List

« Add the sites that

contain the
 JavaFX applet

 Click on OK

| I fFi efox enable
{1Java\Applet plugin

Al
\

() ) /\
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Java Control Panel

| General = Update = Java m Advanced |

@ Enable Java content in the browser

Security level for applications not on the Exception Site list

() Very High
Only Java applications identified by a certificate from a trusted authority are
allowed to run, and only if the certificate can be verified as not revoked.

(*) High
Java applications identified by a certificate from a trusted authority are allowed
to run, even if the revocation status of the certificate cannot be verified.

Exception Site List

Applications launched from the sites listed below will be allowed to run after the
appropriate security prompts.
file:///Volumes/

http://localhost | EditSite List... |

| Restore Security Prompts | | Manage Certificates... |

ek | cancel | Apply
VoW

g

4




Pleiloy (5)) = Serfeie

Java Control Panel

| General = Update = Java mu Advanced |

@ Enable Java content in the browser

fro m th e fl I e SySte m , Security level for applications not on the Exception Site list

. . . () Very High
I e WI t h U R L fl I e - / / / Only Java applications identified by a certificate from a trusted authority are
" " - s 7 allowed to run, and only if the certificate can be verified as not revoked.
(*) High

* Depl JFEX
e p Oy yo u r Java applications identified by a certificate from a trusted authority are allowed

to run, even if the revocation status of the certificate cannot be verified.
l! Exception Site List
f Se rve r ) e . g = p a-C h e Applications launched from the sites listed below will be allowed to run after the

appropriate security prompts.

file:///Volumes/
l

[ In Java Control Panel o
/\ a” W h tt D : //| O C aI h O St | Restore Security Prompts | | Manage Certificates... |

Edit Site List... |

\\\J \
‘ [ A .
u 0 ek | cancel | Appl
. /\ QS f- i N - y,



//localhost/
http://localhost

Pzeiloy G — Oezrer Chiropne, 5

JavaFX applets

Content can not be displayed using
your Web browser. Please open this
page using another browser.

* Internet Explorer (I couldn’t make it run)




Plzeiley (5)) — Slietnl trle el

& build

Categories:

Q
@
v 9

Ne 0o 0 0 @

Sources
Libraries

Build

@ Compiling
© Packaging
o Deployment
@ Documenting
Run
Application
License Headers
Formatting
Hints
JaCoCoverage

Single JNLP deployment file will be generated for Standalone, Web Start and Browser deployment using properties set

in Application, Run and Deployment panels. Active Run Configuration is used from Run panel.

Common Deployment Properties

Icons and Splash Image: None defined

|| Enable Native Packaging

4 Request unrestricted access (Enable signing) [ | Enable BLOB signing

Self-signed Edit...

Signing Certificate:

) WebStart Applications and Applets need to be signed by trusted certificate to ensure future functionality.

@Self—sign by generated key
() Sign by a specified key

Keystore Path: /Users /MyMacBook /Documents /keystore

Keystore Password: eeeeee

tendrilsfx

Key Alias:

Key Password:

arning: Unsigned and self-signed WebStart Applications and Applets are deprecate
from JDK7u21 onwards. To ensure future correct functionality please use trusted
certificate.

| Cancel | [nOKES
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\WIARIRISHAUKESCHIAL

* DukeScript is a new technology that
allows you to write your logic in Java
and render the result to a number of
clients, which can be web browser,
portable devices etc.

* |t achieves this by transforming Java
W - /code to HTML 5 (Javascript) which can

/\ Aru?v in any device. [
\\\ 4 n/\ J\\ £
.1 ‘ / P}\ ‘ f‘ ‘\\\
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https://dukescript.com/

rleow eleas it e ek

p
HTML 5 Browser

android.webkit.WebView

~N

Y

DukeScript

DukeScript

%
<

Y

bck2brwsr

dalvik

AN

Resurrect
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Pres & Clopls

 + Write In Java

* + Write once run everywhere (web,
JavaFX, Android, iOS, ...)

 + API| similar to JavaFX
¢ - not a lot of documentation available
\ * - Need to learn a new API




Tpiseerlieiein

* |In NetBeans Install the DukeScript

plugin

* Tools = Plugins = Available Plugins
» DukeScript Project Wizard
* Mine Sweeper




GrealeranebukesScanappicaien

izl tendrils

| - ' v (& Modules
° I I '@ tendrils Client for JavaFX
File > New PrOJeCt &5 tendrils Client for Web
. Categories: HTML5 @9 tendrils JavaScript Libraries

L@ Dependencies

* Projects: HTMLS with Applicati 5 project Fites
» Provide an artifact & group ic. - & pomxm
* Choose your platform: Browser
« Select Knockout 4 Java Maven Archetype

template
/\ _* Right click on it and choose Build with
i | Dependencies. \ .
\\J v 1~ * Execute tendrils Client for JavaFX /

] AV~ cute tendrils Client for Web \\'\ F:
\ 8/6 Resurre 0 q applets - ete 20 26 \



Werels Dlawme

B z|o|olelloe| 2] o0m

' | /| Automatic

Reload i

Words Demo

'Hello World from HTML and Java!
|Start | Stop | Rotate Few Seconds | | Screen Size!




Nleelify trie Weirels Deple

* Delete DataModel class and any test
classes

» Cleanup the body of static
onPaneload () method of Main

 » Clean up index.html
N * Copy Tendril and Cluster Inner

—_—
-
)

[classes to Main
\[r\ﬂ 3;) the contents of paint () to
1! /@n]%

‘\ «‘59‘

o\ pplets - JCrete 2015
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inelene Rt

<!DOCTYPE html>

<html>
<head>
<title></title>
<meta http-equiv="Content-Type" content="text/html; charset=UTF-
8" >
</head>
<body>
<hl>Words Demo</hl>
<!-- boot bckZ2brwsr -->
<script type="text/javascript" src="bck2brwsr.js"></script>
<script>
var vm = bck2brwsr ('tendrils.js');
var ¢ = vm.loadClass('tendrils.tendrils.BrowserMain');
c.invoke ('main') ;
</script>
</body>

</htmlg¥6/2015 Resurrect iour Java aiilets - JCrete 2015 29



Nlejelity e Weirels P)epnie

« Convert java.awt.Graphics toits
DukeScript equivalent

com.dukescript.api.canvas.Graph
1csContext2D

public static void onPagel.oad ()
throws Exception {

, GraphicsContext2D g =

HTMLOGraphics.getOrCreate ("tendri
1s™);

X cluster.display (g, SEGS, X/2,

W Y/2);

\
A\
\

)

8/6/2015 Resurrect your Java applets - JCrete 2015
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Nlejelity e Weirels P)epnie

« Convert java.awt.Color to its DukeScript
equivalent g.setStrokeStyle

1f (size < 4) {

g.setStrokeStyle (g.getWebColor ("#££0000™)),; //
Color.RED

} else 1f (size < 13) {

g.setStrokeStyle (g.getWebColor ("#00££00™)); //
Color.GREEN

r } else 1f (size < 40) {

g.setStrokeStyle (g.getWebColor ("#00FFEFE")); //
[\ Color.CYAN

} else {

\ g.setStrokeStyle (g.getWebColor ("##FFFF00")),; //
i\ Color.YELLOW

\ }

8/6/2015 Resurrect your Java applets - JCrete 2015
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Nleelify trie Weirels Deple

to its DukeScript equivalent
g.beginPath () ;
g.moveTo (x0, vO0);
g.lineTo (x, V)
g.stroke () ;
'+ Modify index.html
N <hl1>Tendrils Demo</hl>

V‘<ba vas width="600" height="600" \ .
" d:ﬁtndrilS"></CanvaS> Al (

V\ .
/ < ' \ \ N p

-

,\

L]
[o
sJAe

~-/Hoot bck2brwsr —->
Q




Rup the Fanelrils Dare

] Reload |

v ‘ v/ Automatic

BEo/ollol=llol=e/a)] | o0

Tendrils Demo




Deeloviens

web/target/tendrils-web-1.0-
SNAPSHOT-bck2brwsr/public html/:
e 1ib/

e bck2brwsr.js

e Index.html

e tendrils.js
N » - That's it! Open index.html in your

' madern browser and let the magic work!
VA PI'\\IQ Seeurity exceptions any more! \y\‘\ f(f“

l’y\ N1 LS M 1 RJ

~
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» Knockout.js lets you create a direc
connection between the underlying data
and its presentation

 After linking an HTML element with a
particular data object, any changes to
that object are automatically reflected In

' the DOM (automatic dependency
N ,tracking)

i [ E.g. deleting an object from a JS array s
)i de?e es it automatically fromthe

\I” coryesponding H X iiﬂ
)

\ Resurrect ya

—_—
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http://knockoutjs.com/

UL
HTML




Pres & Clopls

* + A lot of documentation
* + Easy deployment
* - write in Javascript

* - Need to learn a new language If not
 already familiar with




Crereite et nlEVIES cieellieettiein

 |[n NetBeans:

* File > New Project
- Categories: HTML5
* Projects: HTML5 Application




<!DOCTYPE html>
<html>
<head>
<title>TODO supply a title</title>
<meta charset="UTF-8">

<meta name="viewport"
content="width=device-width, initial-
scale=1.0">

| </head>

<body>
W <div>TODO write content</div>

* \ </body> /'
[ </html>
Al




Aelel ot ecinveis

<!DOCTYPE html>

<html>

<head>

<title>Tendrils</title>
<meta charset="UTF-8">
<meta name="viewport" content="width=device-width, initial-scale=1.0">
<script type="text/javascript">
function loader () {
var canvas = document.getElementById('canvas');
var context = canvas.getContext ('2d'");

}
</script>

</head>
<body onload="loader () ">

<hl>Tendrils Demo!</hl>
<canvas id="canvas" width="600" height="600">

</canvas>

</body> r

</html>




HECENNTING

var, don't forget this; otherwise JavaScript
assumes it is global variable

int newsize = size / REDUX;| =

* Define classes like so:

vVar Custer = new function () {}
N- Define member methods like so:

Wl Stir .prototype.display = functi@nf

Vi Y /AR




ROGEAICEGE

<script type="text/javascript”>
// Cluster
var Cluster = function() {
var.self = this;
var NUMBER = 7; // Number of helixes in a cluster
self.display = function (g, size, x, Vy) {
for (var 1 = 0; 1 < NUMBER; i++) {
var theta = 1 * 2 * Math.PI / NUMBER;
var t = new Tendril ()

t.display(g, size, theta, x, Vy);

s

b




ROGEAICEGE

// Tendril

var Tendril = £
var.self = t
var NUME = 3
var DENOM =
var RAD = 3.
var DELTHETA
var REDUX =
var MIN = 1;
self.display

for (var
var chng

theta +=
var x0 =
var y0 =
x += RAD
y += RAD

unction () {

his;

0; // Numerator of probability

100; // Denominator of probability

0; // length of line segments

= 0.1; // change in angle theta (in rad)
3; // division of number of helixes

// min number of segments
= function(g, size, theta, x, vy) {
3 = 0; 7 < size; J++) |
= (((DENOM * Math.random()) | 0) < NUME) ? -1

chng * DELTHETA;

Xy

Yr

* Math.sin (theta);

* Math.cos (theta) ; (




}
g
g
g
g

ROGEAICEGE

if

(size < 4) {

g.strokeStyle

g.strokeStyle

g.strokeStyle
else {

g.strokeStyle

.beginPath () ;

.moveTo (x0, vyO0);

.lineTo (x, Vy);

.stroke () ;

"#££0000";
else 1f (size < 13)
"#00££00";
else 1if (size < 40)
"#EE£E££007;

"#0000££";

// Color.red

// Color.green

// Color.cyan

// Color.yellow




ROGEAICEGE

i1f (size > MIN) {
var ¢ = new Cluster () :;
var newsize = size / REDUX;
c.display (g, newsize, x, V);
}
} i

var X = 300;
var Y = 300;

var SEGS = 60; // max number of segments
function loader () {
var canvas = document.getElementById('canvas');
f var context = canvas.getContext ('2d');
var cluster = new Cluster ()

cluster.display (context, SEGS, X, Y);

} _
</script> (




(ros Search

((_-/) @ localhost:8383/Tendrils /index.htm| c

Tendrils Demo!




Deelovians

Tendrils/public html/index.html
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public class Tendrils extends Applet {

public void 1init () {
setSize (600, ©600);
cluster = new Cluster();

this.addMouselListener (new MouseAdapter () {
public void mouseClicked (MouseEvent e) {
repaint() ;
(I
}) s

8/6/2015 Resurrect your Java applets - JCrete 2015 49 a




el B - Mapelrilsa 50X

public class TendrilsFX extends Application {

@Override
public void start(Stage primaryStage) {

scene.addEventHandler (MouseEvent .MOUSE CLICKED,
(MouseEvent event) -> {

g2D.clearRect (0, 0, X, Y);
cluster.display(g2D, SEGS, X/2, Y/2);
event.consume () ;

}) s

8/6/2015 Resurrect your Java applets - JCrete 2015 50 a




var X = 300;

var Y = 300;

var SEGS = 060;
function loader () {

// max number of segments

var canvas = document.getElementById('canvas');
onMouseClick (null) ;

canvas.addEventListener ("click", onMouseClick, true);

}

function onMouseClick (evt) {

var canvas = document.getElementById('canvas');
var context = canvas.getContext ('2d');

context.clearRect (0, 0, canvas.width,
canvas.height) ;

~ var cluster = new Cluster();
cluster.display (context, SEGS, X, Y);

}
Resurrect your Java applets - JCrete 2015 51
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[DUKESCHRE=ERGGIS

<canvas width="600" height="600" id="tendrils"
data-bind="click: $root.refresh()"></canvas>

public final class Main { /**
private Main() { } * Called when the page is ready.
public static void */
main (String... args) throws public static void onPageLoad ()
Exception { throws Exception {
BrowserBuilder.newBrowser () . //DataModel.onPageLoad () ;
loadPage ("pages/index.html") . Data d = new Datal();
loadClass (Main.class) . d.applyBindings () ;
invoke ("onPageLoad", args). }
showAndWait () ;
System.exit (0); }

}

8/6/2015 Resurrect your Java applets - JCrete 2015 52




[DUKESCHREENERGGIS

@Model (className = "Data'", targetId = "",
properties = {})

final class DataModel {
private static final int X = 600;
private static final int Y = 600;

private static final int SEGS = 60; //
max number of segments
private static final Cluster cluster = new

Cluster () ;

private static final GraphicsContext2D g =
HTML5Graphics.getOrCreate ("tendrils") ;

@Function

static void refresh () {
g.clearRect (0, 0, X, Y);
cluster.display (g, SEGS, X / 2, Y / 2);

I 8/3/2015 Resurrect your Java applets - JCrete 2015 53



Dofaeapess

» Kostovarov D. (2013), Deployment In
the Browser, Oracle

* DukeScript official site

» Development Environment for Web
' WebFX
\ - JavaFX in the Browser
/)

b ; Al
'S -
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http://docs.oracle.com/javafx/2/deployment/deployment_toolkit.htm
http://www.dukescript.com
http://dew.apidesign.org/dew/
https://blogs.oracle.com/brunoborges/entry/webfx_running_javafx_as_web
http://blog.netopyr.com/2014/12/19/javafx-in-the-browser-2/

Dofaeapess

Programmlng In Turbo C++, Waite Group.

« Stefanov S. (2008), Object Oriented
JavaScript, Packt.

* |ntroduction to Object-Oriented JavaScript,
Mozilla Development Network.

'+ Geary D. (2012), Core HTML5 Canvas,
N Prentice Hall

0o -Ia%/vkes R. (2011), HTMLS5 Canvas, Y/
) ri

{1 F sofed. e
Y | / ~a r \ \‘
) lets - JCrete 2015

Resurrect

—_—
-



https://developer.mozilla.org/en-US/docs/Web/JavaScript/Introduction_to_Object-Oriented_JavaScript

